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Table 6.1
Overlap One image is refreshed.
Sequential All images displayed are refreshed.

Enlarging images

You can enlarge the image data displayed in the image display area of the main
screen.

1. Click the [Zoom] button (see Figure 6.24). The image being displayed in the
image display area will be enlarged.

Capture Landmarks Zoom button

Figure 6.24

*  When you enlarge an image, the [Zoom] button is changed to
the original size mode (see Figure 6.25). Click the [Zoom]
button again to restore the image to its original size.

Enlargement mode Original size mode

Figure 6.25

» Magnification varies in the image view mode (see Table 6.2).
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Table 6.2
Image view mode Magnification
1 Display mode X2
2 Display mode x1.5
4 Display mode - (not available)

Structure enhancement

Use the [Enhance] buttons to emphasize the patterns on the surface of the
mucosa (see Figure 6.26).

Enhance buttons

Capture Landmarks Enhance

Figure 6.26
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NOTE
The structure enhancement level can be switched between
“Normal” and “High” (see Table 6.3).
Table 6.3
Enhancement level Detail
Normal The image is displayed without structure
enhancement applied.
High The image is displayed with structure enhancement

applied.

Antenna display

The antenna display identifies the antenna with the best signal reception.

CAUTION

The antenna information is for reference only. Do not depend
on this information to determine the position of the capsule
endoscope.

1. Click the [Antenna] button in the antenna display section (see Figure 6.27).
The antenna display panel is displayed.

Antenna button

el thom g

Figure 6.27

Click the [Antenna] button again to hide the antenna display
panel.
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Creating thumbnails

Clicking the [Capture] button while the playback of image data is paused will
create and display thumbnails of the image data in the thumbnail view area (see
Figure 6.28).

To create thumbnails, double click on the image display area.

Capture button

VIV _IFEV_IEV_IEV_IFEY _IFV_IFY IV IFV_IFVY YV _IEV IV Y

9 4 94 99 @ Q@ QP QO @ 4

00:0051 00:00:52 00:00:53 00:00:54 00:00:56 00:0056 00:00:57 00:00:58 00:00:59 00:00:60 00:0031 00:00:62 00:00:63 00:00:64 00:00:65

Thumbnail view area

Figure 6.28

When you click the [Capture] button during the playback of
image data, a thumbnail will be created for the image being
displayed at that moment, and the playback of image data
will be paused.

Removing thumbnails

1. On the thumbnail view area, select the thumbnail you wish to remove.

2. Right-click on the selected thumbnail to display the context menu (see
Figure 6.29).

Starting point of marker
End point of marke

Figure 6.29
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3. Select “Remove” from the context menu to delete the selected thumbnail.

NOTE

* You can also press the “Delete” key on the keyboard to
delete the selected thumbnail.

+ If the thumbnail included in the reporting group is removed,
one of the below messages is displayed.

- The selected thumbnails are added to a report. If you
delete these thumbnails, they will be removed from a
report.

- If you delete the selected thumbnails, the comments
added to the group which contains these thumbnails will
be deleted.

+ If no thumbnail has been created, pressing the land mark will
create a new thumbnail.

Setting features

You can set a featured region on the time bar to identify the range of images
(small bowel area) to focus on.

1. Click and select a thumbnail to set a feature.

2. Click the [Landmarks] button on the thumbnail and select “Landmarks” from
the context menu (see Figure 6.30).

Landmarks button

_tigh

Normal

Capturs Landmarks Enhance

Figure 6.30
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3. The feature setting screen is displayed (see Figure 6.31).

Figure 6.31

Table 6.4

No marker No marker is set for the images.

Starting point of Sets the selected thumbnail as the first image of the

marker marker area.

End point of Sets the selected thumbnail as the last image of the
marker marker area.

Origin for Sets the selected thumbnail as the origin of a relative time
relative time scale.

LT

4. Select “No marker”, Starting point of marker”, or “End point of marker” to set

the marker area. Also set the origin for the relative time.

NOTE

* Only one thumbnail can be used as the starting point of
marker, and as the end point of marker.

» To set the selected thumbnail as origin of a relative time
scale, check the checkbox for “Relative time”.
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5. Click the [OK] button. The feature interval is now set.

+ If you right-click on the thumbnail, the context menu which
contains the items in the Table 6.4 appears.
You can set features by selecting one of the context menu.

* Click [Cancel] to discard the settings and exit the feature
setting screen.

» The configured feature interval is shown in a different color
on the time bar.

* When only the “Start of feature interval” is specified, the last
image of the data set becomes the “End of feature interval”.

*  When only the “End of feature interval” is specified, the first
image of the data set becomes the “Start of feature interval”.

Time bar

The time bar indicates the position of the currently displayed image relative to
the overall timeframe (see Figure 6.32).

Time bar

- 4‘ 1 Ceeiedidsdds

359 09.34.00 09.34.00 09.34.01 09.34.0' 09.34.027 09.34.02 0934.03 09.34.03 09.34.04 09.31.04 09.34.05

Figure 6.32

The thumbnails are connected with a line to a position on the time bar that
corresponds to the time at which they were captured.

NOTE

»  When you drag the indicator on the time bar to the left or the
right, the image data being displayed in the image area is
updated accordingly.

+ The time bar becomes interrupted when the recorder unit is
turned OFF or when signals are not being received.
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*  When you click on the time bar, the indicator moves to the
clicked position, and the image area is updated to display the
corresponding image.

Red color detection bar

[ )
Red

Figure 6.33

The red line on the red color detection bar indicates the position of red-color
detected image data.
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6.4 Generating reports

Preparing to generate a report

Q Report preparation screen

5. Back button

4. Next button

3. Change sequence button

6. Thumbnail view area 7. Image display area

8. Comment area

2. Make group button

1. Group display area

9. User dictionary

Figure 6.34

. Group display area

Displays images as groups.

. Make group button

Groups images.

. Change sequence button

Displays the group edit screen for changing the group ordering.

. Next button

Displays the report generation screen.

. Back button

Returns to the main screen.

. Thumbnail view area

Displays thumbnails to be selected as members of a group.

. Image display area

Displays thumbnails selected in the thumbnail view area or the group
display area.

. Comment area

Allows attaching comments to a group.
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9. User dictionary
Used when entering comments. As you type into the comment area, terms
starting with the characters you have entered will be searched for and

displayed.

O Grouping images

Only the images that have been assigned to a group can be included in a report.
You can associate a comment to each group.

1. Click the [Report] button on the main screen (see Figure 6.35). The report
preparation screen is displayed.

Report button

Figure 6.35

2. From the thumbnail view area, check the checkbox under the thumbnail you
wish to include in the reporting group (see Figure 6.36).

e
-
‘ A

Go3k02 | 0eak02

Thumbnail view area

Figure 6.36
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NOTE
To select multiple images, check the checkboxes under the
thumbnails (see Figure 6.37).
Checkbox
Figure 6.37

3. Click the [Make group] button (see Figure 6.38). Selected images are
displayed in the group display area and a group is created.

Make group button

Figure 6.38

Images that are already grouped will be greyed out in the
thumbnail view area.
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QO Adding images to an existing group

To add images to an existing group, drag and drop the thumbnails from the
thumbnail view area onto the destination group.

1. In the thumbnail view area, select the thumbnails you wish to add to the
group.

To select multiple images, check the checkboxes under the
thumbnails.

2. Drag the selected thumbnails onto the destination group (see Figure 6.39).
The selected images are added to the group.

09:34.20 09.3441

09:34:56 09:35:30

Figure 6.39

O Removing images from an existing group

To remove unwanted images from a group, drag and drop the thumbnails from
the group onto the thumbnail view area.

1. Inthe group display area, select the thumbnails you wish to remove from the
group.

To select multiple images, check the checkboxes under the
thumbnails.

2. Drag the selected thumbnails onto the thumbnail view area. The selected

images are removed from the group.

NOTE

In the thumbnail view area, ungrouped images will no longer
be greyed out.
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QO Moving images from one group to another

To move images from one group to another, drag and drop the thumbnails
between the groups.

1. In the thumbnail view area, select the thumbnails you wish to transfer.

» To select multiple images, check the checkboxes under the
thumbnails.

* You cannot select thumbnails from multiple groups.

2. Drag the selected thumbnails onto the destination group (see Figure 6.40).
The selected images are transferred.

loa33se’ T

y

09:35:30

09:34:41

09:34:56 ~ 093530 T

Figure 6.40
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QO Drawing ovals on observation images
You can draw ovals on images to indicate areas of interest.

1. Click the [Oval] button on the image display area (see Figure 6.41).

Oval button

Figure 6.41

NOTE

The image display area displays the image for the thumbnail
selected in the thumbnail view area or the group display
area.

2. Click & drag on the image in the image display area to draw an oval (see
Figure 6.42).

Figure 6.42

* The oval will be centered around the point where the mouse
was clicked.

* Release the mouse button to complete the oval.
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* An oval that extends beyond the limits of the image display
area will not be shown.

3. To undo the oval(s) you have drawn, click the [Undo] button.

To delete an oval, select the oval and press the [Delete] key
on the keyboard.

O Drawing arrows on observation images
You can draw arrows on images to point out areas of interest.

1. Click the [Arrow] button on the image display area (see Figure 6.43).

Arrow button

Figure 6.43

The image display area displays the image for the thumbnail
selected in the thumbnail view area or the group display
area.
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2. Click and drag on the image in the image display area to draw an arrow (see
Figure 6.44).

F O

Oval Amow

Figure 6.44

NOTE

» The arrow will be drawn from the point where the mouse was
clicked.

* Release the mouse button to complete the arrow.

* An arrow that extends beyond the limits of the image display
area will not be shown.

3. To undo the arrow(s) you have drawn, click the [Undo] button.

To delete an arrow, select the arrow and press the [Delete]
key on the keyboard.

O Entering comments

A comment can be attached to each group. Input your comment using the
keyboard or the user dictionary.

1. Onthe report preparation screen, type in your comment into the comment
area.

2. Words that start with the entered character string are displayed in the
candidate display area.

NOTE

» A candidate is displayed when a character is entered
following a space.
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* As you type into the comment area, terms starting with the
characters you have entered will be searched for and
displayed in the user dictionary area. To enter a term from the
dictionary, select the term and press the [Enter] key on the
keyboard.

3. Use the up/down arrow keys on the keyboard to select the word you wish to
enter from the candidate display area.

4. Press the [Enter] key on the keyboard to enter the currently selected word
into the comment entry box.

* You can also click on a word in the candidate display area to
enter it into the comment box.

+ To change the language when entering comments, right-click
on the comment area and select the language.

O Editing the user dictionary
Words that are frequently used in reports can be registered in the user dictionary.
1. Click the [Edit] button on the report preparation screen. The user dictionary
edit screen is displayed.

2. Toadd a word or phrase to the user dictionary, type the text into the text box
on the user dictionary edit screen, and click the [Add] button.

3. To remove a word or phrase from the user dictionary, select a registered
word or phrase from the user dictionary, and click the [Remove] button.

=

My dictionary ]

Figure 6.45
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Q Sorting groups

1. Click the [Change sequence] button on the report preparation screen (see
Figure 6.46). The group edit screen is displayed.

Change sequence button

Figure 6.46

2. Select the group you wish to reorder.

3. Drag and drop the selected group to achieve the desired ordering of groups
(see Figure 6.47). The groups are rearranged.

Figure 6.47

4. Click the [OK] button. The change is applied, and the report preparation
screen will be displayed. Click the [Cancel] button to discard the changes
and return to the report preparation screen.
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Generating reports

QO Report generation screen

6. Patient data 7. “Display antenna”
display area checkbox

5. Examination information
display area

8. Individual information

4. Referring checkbox

physician entry
box

9. Age checkbox

information:
000000020050729
ROW

3. Reason for
referral entry

7129/2005
pi

2. Findings/procedure

entry box 10. “Signature”
checkbox
1. Summary entry ]
box A || b 11. “Facility logo”
. blood
caﬁc\noma Checkbox
EGOOdﬂenal erosion

-wuw

Figure 6.48
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1. Summary entry box
Used to enter a summary.

2. Findings/procedure entry box
Used to enter findings and procedures.

3. Reason for referral entry box
Used to enter reasons for referral.

4. Referring physician entry box
Use to enter the name of the referring physician.

5. Examination information display area
Displays examination information that has already been set.

6. Patient data display area
Displays patient data that has already been entered.

7. “Display antenna” checkbox
Check to display antenna information on the report.

8. Individual information checkbox
Check to generate a report that does not contain information about the
individual.

CAUTION

To remove individual information (such as a facial portrait)
from the image data, you will need to set the hiding feature.
For more information, refer to “Hiding images” on page 216.

9. Age checkbox
Check to generate a report that does not include the patient’s age.
10. “Signature” checkbox
Check to generate a report with a signature block.

11. “Facility logo” checkbox
Check to display a facility logo on a report.
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O Displaying the report generation screen

1. Click the [Next] button on the report preparation screen (see Figure 6.49).
The report generation screen is displayed.

E‘ Image selection screen for report

:Smg\a thumbnails

Next button

Figure 6.49

2. Contents specified on the initial setup screen are displayed (see Figure
6.50).

Figure 6.50

Only grouped images are displayed.

3. Images grouped on the report preparation screen are displayed by group.

180 OLYMPUS OLYMPUS CAPSULE ENDOSCOPE SYSTEM



Chapter 6 Capsule Endoscope Image Observation

Displaying print previews
You can preview how the report will appear when printed.

1. Click the [Preview] button on the report generation screen (see Figure 6.51).
The print preview of the report is displayed.

ClEBAE

[
Bqort Save

4 Display Antennz
B Make anonymous
@ Delete patient's age

@ signature

Preview button

w4 Display a facility logo

Figure 6.51
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Q Print preview screen

6. Next Page button

5. Page number

7. Last Page button

4. Previous Page button

8. Zoom out button

3. First Page button 9. Magnification

/ 10. Zoom in button

2. Print preview area

1. Back button 11. Print button

Figure 6.52
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1. Back button
Returns to the report generation screen.

2. Print preview area
Displays the print preview.
3. First Page button
Displays the print preview for the first page.
4. Previous Page button
Displays the print preview for the previous page.

5. Page number
Shows the page number for the displayed page.
6. Next Page button
Displays the print preview for the next page.
7. Last Page button
Displays the print preview for the last page.
8. Zoom out button
Zooms out the print preview.
9. Magnification
Shows the magnification used to display the print preview.
10. Zoom in button
Zooms in the print preview.

11. Print button
Displays the print setup screen.
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Q Printing reports

1. Click the [Print] button on the report generation screen (see Figure 6.53) or
the print preview screen. The print setup screen is displayed.

DeDE

=
Export Save

T Display Antenna

B Make anonymous

- 1
1] B Delete patient's age Print button
1 & Signature
:l &4 Display a facility logo
]
Figure 6.53
NOTE

You can also display the print setup screen by clicking the
[Print] button on the print preview screen.

2. Click the [Print] button on the print setup screen (see Figure 6.54). The
report is printed.

& Print
General | Options
Select Prrter
) [a]
:
=2
Add Printer  [FEBSRESS]
Inkjet 1200} [
. Series ! ~
Status Ready [JPrirttofie | Preferences
Location:
Page Range
@A Number of copies: [1 Fa) Print button
QPages: |1 T
Enter sither 2 single page number or a single E
page renge. For example, 5-12

Figure 6.54

» By default, the reports are adjusted to print to letter size
paper.
* You can select the paper size from letter the size or A4.

+  When A4 size is selected, the print size will be automatically
scaled to match the paper size.
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You can export the generated report in HTML format.

1. Click the [Export] button on the report generation screen (see Figure 6.55).
The destination setting screen is displayed.

@ Delete patient's age
@ signature

& Display a facility logo

B Make anonymous

Export button

Figure 6.55

2. Select the destination (see Figure 6.56).

Drive:

Free space:

noo(Ge)S0%

Figure 6.56

When exporting a report from the workstation, you can only
export to external drives.

When exporting a report from the Endo Capsule software
light version of the PC, you can export to any drive.
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3. Click the [OK] button (see Figure 6.57). The report is exported to the
selected destination.

OK button

Drive:

Free space:

Figure 6.57

NOTE

» The report is exported in HTML format.
» The exported report can be viewed by any HTML browser.

Saving reports
You can save the generated report. The report can also be saved as a draft.

1. Click the [Save] button on the report generation screen (see Figure 6.58).
The save screen is displayed.

& signat Save button

4 Display a facility logo

Figure 6.58
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2. To finalize the report, click the [Finalize] button (see Figure 6.57). A report
file is generated in HTML format.

O

Finalize Save draft

© &

Finalize

Figure 6.59

NOTE

» To save the report as a draft, click the [Save draft] button (see
Figure 6.58). When the report is finalized, an HTML file of the
report is created and the report history is recorded. When the
report is saved as a draft, an HTML file of the report is not
created and the report history is not recorded.

r

==

Finalize Save draft

©

Save draft button

Figure 6.60

» Save the thumbnail data frequently to prevent possible data
loss due to a breakdown.

* You can also save the thumbnail data by selecting “Save
thumbnail” from the “File” menu. In this case, an HTML file of
the report is not created and the report history is not
recorded.

CAUTION

Finalize the report before you write the report onto the DVD.
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Viewing the report history
You can view past reports by selecting them from the report history.

1. Select “History” from the “Tools” menu on the report generation screen when
you open the examination data in the drive other than DVD. The history
screen is displayed.

ﬂ RE-1 communication USB 0.0.2.0 WS-

09:33:2%
0o:00:12

Tools

Recorder

Figure 6.61

Select "History*“ from the "Tools" menu on the main screen
when you open the examination data in the DVD (see Figure
6.61). The history screen is displayed.

2. From the report history, select the report you wish to view, and click the
[Open] button (see Figure 6.62).

Open button

Figure 6.62
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3. The selected report is displayed on the report preview screen.

Click the [Cancel] button on the history screen to exit the
history screen.
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6.5 Examination data management

CAUTION
While writing to or reading from a USB memory, do not
remove the USB device from the port. It may damage
examination data and/or the USB device.

NOTE

» The “Examination Data Management” function is not
available in Endo Capsule Software Light.

* Remove the USB devices from the workstation and restart
the workstation when it does not work properly. Then connect
the removed USB devices again.

» The report file is exported to the following location.

[E] =»* Removable Disk (G:)
B ) CPData
H I [User ID]_[Examination date] _[ather imformation]
|2 report
gﬁj [Report file].mht

(*) Words in parentheses vary according to the exported
data.
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Examination list screen

10. Disk space information

/1000 (GB)

| 60000000000000000000 er 2005/01/01

00000000000000000000 er 2005/01/01

00000000000000000000 er 2005101101

3 . B ack b utto n 00000000000000000000 er 2005/01/01
00000000000000000000 er 2005/01/01

00000000000000000000 er 2005/01/01

00000000000000000000 er 200501101

00000000000000000000 er 2005101101

00000000000000000000 er 2005101101

00000000000000000000 er 2005/01/01

00000000000000000000 | Patient 11 2005/01/01
00000000000000000000 | Patient 12 2005/01/01
00000000000000000000 | Patient 13 2005/01/01

2. Drive selection box 00000000000000000000 | Patient 14 200610101

1. Examination list

Checkin Checkout %]

4. Open button 9. DVD button
5. Check in button 8. Copy button
6. Check out button 7. Delete button
Figure 6.63

1. Examination list
Displays the list of examination data stored on the selected drive.

2. Drive selection box
Select the drive on which the examination data you wish to view is stored.
3. Back button
Returns to the main screen.
4. Open button
Opens the selected examination data.
5. Check in button
Checks in the selected examination data.
6. Check out button
Checks out the selected examination data.

7. Delete button

Deletes the examination data and the thumbnail data.
8. Copy button

Displays the examination data copy screen.
9. DVD button

Displays the DVD writing screen.

10. Disk space information
Displays the free space of the selected drive.
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Displaying the examination list screen

NOTE

The following icons are displayed in the “Status” column of
the examination list.

Icon Caption Explanation
Original The examination data which has been downloaded
from a recorder.
Imported The examination data which is imported from a
external storage to the workstation.
With archive The archived examination data in the workstation.

Checked out

The examination data in the workstation which has
been checked out.

Password protected

The examination data protected by a password.

o @ =0 @ W ¥

Anonymous

The examination data from which the individual
information has been removed.
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examination list screen is displayed.

List button

File Tools Help

||
dip
Main

Figure 6.64

2. To exit the examination list screen, click the [Back] button (see Figure 6.65).

Back button

Fie Tools Help

@ B List management

ID
00000000000000000000

& Workstation v

Patient 00

00000000000000000000

Patient 01

00000000000000000000 Patient 02
00000000000000000000 Patient 03
00000000000000000000 Patient 04
00000000000000000000 Patient 05
00000000000000000000 Patient 06
00000000000000000000 Patient 07
00000000000000000000 Patient 08

Figure 6.65
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Checking out the examination data

You can copy the examination data and thumbnail data from the workstation onto
an external drive, and edit the copied thumbnail data. You cannot edit thumbnail
data on the source workstation until the copied data is restored to the
workstation. This is referred to as the “check-out” function.

1. From the examination list on the examination list screen, select the
examination data associated with the thumbnail data you wish to check out.

2. Click the [Check Out] button (see Figure 6.66). The thumbnail data selection
screen is displayed.

2005/01/01

{ 20050101
2005101701
2005101701

Check out button

Figure 6.66

3. From the thumbnail data list on the thumbnail data selection screen, select
the thumbnail data you want to check out (see Figure 6.67).

Report date Attending physician

HEW —

bympus ]
20060803233845 olympus
20060803013420 olympus

<

Figure 6.67

To create a new thumbnail data, select “New” (top row) from
the examination data list.
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. Click the [OK] button (see Figure 6.68). The check-out destination selection
screen is displayed.

L L
olympus

olmpus OK button

Figure 6.68

. Use the drive selection box to select the drive to which the data is checked

out and click the [OK] button. The examination data and the thumbnail data
are copied to the check-out destination (see Figure 6.69).

Drive

Free space

5 £ 2005/01701 Drive selection box

© £3 Aaaaa AAAAA

Figure 6.69
CAUTION
The internal hard drive of the workstation cannot be selected.
Select an external drive.
NOTE

» Check the “Password” checkbox to set a password for the
check-out function.

+ If you specify a password when checking out the data, you
will be required to enter the password to open the thumbnail
data.

» Click the [Cancel] button to exit the check-out destination
selection screen.
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If there is insufficient storage space on the selected
check-out destination, you can make free space by deleting
the unnecessary files.

While copying the data to the check-out destination, a
progress screen will be displayed. To stop the copying
process, click the [Cancel] button on the progress screen.

The examination data (**+.0pg) and the thumbnail data
(x==.xml) is exported to the following location.

=] == Removable Disk (G:)
= I3 CPData
[ [User ID]_[Examination date] _[other imformation]

[User ID]_[Examination date]_[other imformation].opg
[User ID]_[Examination date]_[other imformation]. xmil

() Words in parentheses vary according to the check out
data.
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Checking In the thumbnail data

Once you have finished editing the checked out thumbnail data, you must return
it to the source workstation. This is referred to as the “check-in” function.

1. Select the checked out examination data and click the [Check in] button
(see Figure 6.70). The check-in source selection screen is displayed.

| 2006i01/01

~ 2005{01/01 |
2005/01/01

200501101 |

Check in button

P EE O

pen Check in Check out Delete

Figure 6.70

2. Use the drive selection box to select the drive that contains the checked out
thumbnail data which you wish to check in (see Figure 6.71).

Drive

Free space: 100(GR)5 0%

Drive selection box

Figure 6.71

Only external drives can be selected.
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3. Clickthe [OK] button (see Figure 6.72). The thumbnail data selection screen
is displayed.

OK button

Figure 6.72

4. From the list of thumbnail data, select the thumbnail data you wish to check
in (see Figure 6.73).

Thumbnail data

Figure 6.73
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5. Click the [OK] button (see Figure 6.74). The thumbnail data being checked
in is saved, and the check-in process is complete.

OK button

Figure 6.74

NOTE

If you select “New” from the list of thumbnail data when
checking out the data and do not make the thumbnail data on
Endo Capsule Software Light, you can not check in the
thumbnail data. To release a check-out, see “Releasing the
check-out” on page 200.
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Releasing the check-out

If the checked out thumbnail data cannot be checked in, perform the
following steps to release the check-out.

CAUTION

If you release a check-out, the checked out data cannot be
saved.

1. Log in as an administrator.

2. Click the [List] button on the main screen (see Figure 6.75). The
examination list screen will appear.

File Tools Help

]
qup
Main

List button

Figure 6.75

3. Select the checked out examination data (see Figure 6.76).

Examination data

2008001101
2005001101

Figure 6.76
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4. Right-click the examination data and select “Check out” from “Reset” in the
context menu (see Figure 6.77). The check-out is released.

@ List management

R | 64164(GB) 99%

BT

Figure 6.77
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Importing examination data from external drives onto the
workstation

You can import examination data from a DVD or an external drive (such as an
external hard disk) onto the workstation.

1. Using the drive selection box on the examination list screen, select the
external drive that contains the examination data (see Figure 6.78).

Drive selection box

Figure 6.78

2. From the examination list, select the examination data you wish to import
onto the workstation (see Figure 6.79).

Examination data

Figure 6.79
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3. Click the [Import] button (see Figure 6.80). The thumbnail data selection
screen is displayed.

Import button

Figure 6.80

4. From the list of thumbnail data, select the thumbnail data you wish to import.

5. Click the [OK] button (see Figure 6.81). The examination data and the
selected thumbnail data are imported onto the workstation.

Examination

0123436788

Thumbnail OK button

Report date Attending physician

Or. Izzz 11772
2006/03 701 Dr. Yy VY
[ 2005/04 f01 Dr. s )00

Figure 6.81

NOTE

» If there is insufficient storage space on the internal hard drive
of the workstation, the error message will be displayed.

+ “Cannot import data because workstation does not have
sufficient disk space” message is displayed. Create enough
disk space to import data.
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Copying examination and thumbnail data

1. Select the examination data you wish to copy and click the [Copy] button on
the examination list screen (see Figure 6.82). The copy screen is displayed.

2005101101 |
e
200501101
200501001

Copy button

Figure 6.82

* You can select multiple examination data simultaneously.
The thumbnail data associated with the selected examination
data will be copied automatically.

» To exit the copy screen, click the [Cancel] button.

2. Use the drive selection box to select the destination drive on the copy

screen (see Figure 6.83). The amount of available disk space on the
selected drive is displayed.

Drive:

Drive selection
box

Figure 6.83

The folder for the examination data will be created
automatically during the copying process.
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3. The selected examination data which you wish to copy is displayed. (see
Figure 6.84).

Selected examination /
data

Figure 6.84

4. Click the [Option] button to display the data copy options screen (see Figure
6.85).

| [Eeccobeere Jowsoeor ] Option button

/100 (GB)

Figure 6.85

5. Select the type of files to be copied together with the examination data. Click
the [Picture] button to copy still images, and the [Movie] button to copy video
files (see Figure 6.86).

OLYMPUS OLYMPUS CAPSULE ENDOSCOPE SYSTEM 205



Chapter 6 Capsule Endoscope Image Observation

Picture button

Movie button

Figure 6.86

All items are selected by default.

6. Click the [OK] button to save the settings and exit the data copy options
screen (see Figure 6.87).

OK button

Figure 6.87
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/. Check the “Password” checkbox to set a password (see Figure 6.88).

Password
checkbox

Freespace: =~ (RERRERRRRRRERERER

% Make anonymous

4 Password:

Figure 6.88

If you specify a password when copying the examination
data, you will be required to enter the password to open the
copied examination data.

8. Check the “Make anonymous” checkbox to copy the examination data with

the individual information removed (see Figure 6.89).

checkbox

Make anonymous

Free space:

¥ Make anonymous

4 Password.

Figure 6.89

Individual information removed include “Patient name” and
“Image showing individual information”.

To remove “Image showing individual information”, you will
need to set the hiding feature. For more information, refer to
“Hiding images” on page 216.
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9. Click the [OK] button on the data copy screen (see Figure 6.90). The

selected examination data will be copied. The progress screen is displayed
while the examination data is being copied.

OK button

/100 (GB) % |

rALC b

Figure 6.90

» To stop the copying process, click the [Cancel] button on the
progress screen.

+ If there is insufficient storage space on the copy destination,
an error message will be displayed. In this case, refer to
Chapter 8, “Troubleshooting” on page 233.

+ Do not remove an external storage device while copying.
Copying will fail and if may cause hang-up of the workstation.

10. When the copying of examination data is complete, you will be returned to
the examination list screen.
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Deleting examination and thumbnail data

NOTE

The examination data which has not been archived can not
be deleted.

1. Select the examination data you wish to delete and click the [Delete] button
on the examination list screen (see Figure 6.91). The examination data
deletion screen is displayed (see Figure 6.91).

2006/01/01
2005101701
2005/01/01
2005/01/01

Delete button

In Check in Check out

Figure 6.91

* You can select multiple examination data simultaneously.

» To exit the screen, click the [Cancel] button.

2. The selected examination(s) which you wish to delete is displayed (see
Figure 6.92).

Select
examination data

Figure 6.92
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